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Learning Objectives 
 Understand the various versions of VRED and the API capabilities of each 

 Understand the different ways to extend VRED 

 Be able to write a simple extension to VRED using the API 

 How to create custom user interfaces for VRED  

Description 
This course will provide an overview of VRED Professional software’s API, with a focus on how to create 
custom user interfaces. Topics will include the various VRED software products and the level of API 
support for each; an introduction to Python scripting programming; instructions on how to use the VRED 
Professional software’s API; and instructions on how to integrate your Python code into VRED 
Professional software. We will also cover what's new in the VRED Professional 2016 software’s API; an 
introduction to PySide software; an example of VRED Professional software custom user interfaces using 
PySide; and how to control VRED Professional software from a web browser, as well as other topics.  

Your AU Expert 

Bill is a graduate of Simon Fraser University in Canada and has worked as a software developer on 
product development teams at Wavefront Technologies, Alias, and Autodesk. As part of the Maya 
development organization he managed the API team. For the past ten years, Bill has focused his efforts 
on consulting where he creates unique solutions for customers using the APIs of VRED, Showcase, Maya, 
MotionBuilder and Stingray. Bill has also created several Augmented Reality applications that allow 
designers to explore virtual 3D models through mobile devices.  
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Examples plug-ins created with the VRED API 
I’ll give a quick demo of the various examples I want to highlight during my talk, then outline what level 
of API support is available in each version of VRED. 

Some examples of what you can create with VRED’s API 
To illustrate some of the capabilities of the VRED API, here are a few example plug-ins. I’ll describe how 
each of these works in detail later, but just wanted to show you up front what is possible: 

1) Print a simple message on the VRED terminal window 
Example: Define a function that we can call multiple times to perform complex operations. 

 

Figure 1) Print a message on the terminal window.  See Hello, world! for details. 

Next, let’s create a python function that creates and positions a randomly colored cube: 

 

Figure 2) I create a function that defines a randomly-colored box and call it ten times to generate 
and position geometry. See Automation using the VRED API. 
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2) Creating UI within the viewport  

 

Figure 3) Here I use the VRED API’s “vrMenu” function to create a UI within the 3D view. I’ll show 
you how to do this in Creating an in-viewport user interface. 

3) Placing a web browser inside the viewport 

 

Figure 4) The Autodesk home page is displayed in a web interface inside the viewport. See Placing a 
web interface inside the viewport. 
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4) Using vrWidget to create UI in a separate window 

 

Figure 5) Custom UI. See Creating UI in a separate window using vrWidget. 

5) Defining a custom UI in an external application 

 

Figure 6) A web browser can provide a standalone UI that interfaces with VRED. See Creating UI 
in a standalone application. 
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Using VRED’s interface to Qt to create a custom UI 

 
Figure 7) A UI created with PythonQt. 

Understand the various versions of VRED and their API capabilities 

About the VRED API 
VRED’s API uses the “python” language, a scripted language with classes and functions similar to C++. In 
the appendix to this handout there is a short introduction to python. As of VRED 2016, the API contains: 

 854 built-in functions which perform actions. For example, creating a sphere. 

 52 classes to create and access objects, for example moving an object. 

 Built-in support for many popular python libraries, such as the PySide UI module. 

 Easy to add additional python libraries, and even create your own libraries. 

The VRED API is very powerful, but it is important to note that the level of API capabilities varies with 
the version of VRED you are working with. 

The different versions of VRED 
VRED comes in different flavors and each has slightly different API capabilities. The VRED API can also be 
accessed via the “Terminal” window or through a “port” depending on the version of VRED being used. 

 VRED Professional:  Targeted at automotive designers, VRED Professional has the ability to 
create high-end visualizations and virtual prototypes. Full API support. 

 VRED Design: Allows designers to review and evaluate design ideas in real time. API support is 
read-only, meaning that the values can be queried, but not updated.  

 VRED: Allows product designers to visualize 3D models on the fly. No API support.  

The following table outlines the level of API support for each version of VRED: 

Version API and command terminal Web Interface 

Autodesk® VRED Professional   

Autodesk® VRED Design Read only Read only 

Autodesk® VRED   

 

For the purpose of this class, I will focus on the API capabilities of Autodesk® VRED Professional. 
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Understand the different ways to extend VRED 
Next, I want to outline the various ways you can extend VRED using the API, and what the types of 
operations that are possible with the API. 

Accessing the API in VRED  
There are a variety of ways to access VRED’s API: 

 Terminal: VRED provides a Terminal window that allows users to enter python commands. This 
was shown in my first example, “Hello, world!”. 

 Web Interface: By enabling the Web Server interface, commands can be sent to VRED from an 
external application such as a web browser. This is shown in my “Web Browser” example. 

 Preferences: In the Script section of Preferences, the user can add python commands that are 
run every time a new scene is created. 

 Variant Sets: You can associate python commands with each variant set. These commands get 
run when the Variant Set is activated. 

What the API can do for you 
The API provides access to a wide variety of functionality within VRED. As I mentioned earlier, I won’t go 
through every class and every function in the API, my goal here is to just provide an overview.  

We can group these capabilities into eight categories: 

 

 

 

 

 

 

 

 

 

 Devices: Interact with various input devices. 

 File I/O: Read files into VRED and write files out. 

 Materials: Create and apply materials to objects in the scene. 

 Render settings: Control rendering parameters such as quality and resolution. 

 Scene graph: Access the structure of the currently loaded scene, positioning, creating, parenting 
and deleting objects in the hierarchy. 

 Variants: Access the variants structure in the current scene, 

 User interface: Creating custom UI panels. 

You can access interactive documentation from the “Help” menu in VRED by clicking on “Python 
Documentation”. This talk will focus on the User interface part of the API. 

  

VRED API 

Devices 

File I/O 

Materials 

Render settings Scene graph 

Variants 

User interface 
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What’s new in the VRED 2016 API 
Here is a list of the high-level enhancements to the API in VRED 2016. 

 Updated python support to version 2.7.8 

 Updated API examples 

 Added PythonQt to allow access to the Qt UI framework 

 Added interface to the Surface Analysis tool 

 vrWidget now supported  on Macintosh 

 Custom functions now work through WebServer on Macintosh 

 Added specific functions such handling configuration files, flush transforms, script editor control 

 

Writing a simple extension to VRED using the API 
Now I’ll go through the steps for printing a message on the terminal window 

Hello, world! 
VERD contains a special window where you can enter python commands and also view status messages 
from the application. Open the “View” pull-down menu and select “Terminal”.  

 

Figure 8) View pull-down menu 

The “Terminal” panel will appear. In the “root:” text-field at the bottom of the window type the 
following command to print the string “Hello, world!”, then press ENTER. 

print “Hello, world!” 

You will see the string “Hello,world!” echoed back to the terminal window. Figure 9 on the 
following page shows what the Terminal Window should look like.  
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Figure 9) “Hello, world!” is printed to the VRED terminal 

Congratulations! You have written your first python program for VRED. I have also included a python 
primer in the Appendices of this document 

Here is the complete python code for this example to enter into the Terminal Window: 

print “Hello, world!” 

Using the VRED API to create and manipulate geometry 
We’re going to make a sphere and translate it. This is very easy. Type the following command into 
VRED’s Terminal window to create a sphere with 8 subdivisions, radius of 100 units, and orange color. 
Press ENTER when you have finished typing: 

sph = createSphere( 8, 1000, 1.0, 0.5, 0.0) 

An orange sphere will appear onscreen: 

 

Figure 10) Using the VRED API to create a sphere 
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When I typed the createSphere command note that I assigned the result to the variable “sph”. Each 
variable in python has a type and we can query the type of a variable as follows: 

print type(sph) 

<class ’vrNodePtr.vrNodePtr’> 

This means “sph” is of type “vrNodePtr” which the VRED API class for representing a node. You can 
query what functions are available for the class using python’s dir command: 

print dir(sph) 

['__class__', '__delattr__', '__dict__', '__doc__', 

'__format__', '__getattribute__', '__hash__', '__init__',  

Actually, I’ve truncated the list, there are many more names listed, and this list will match what you see 

in the online documentation (Help>Python Documentation and search for the vrNodePtr 
class). Each name printed is a function you can call on the object.  

For example, to get a node’s location use the vrNodePtr class’ getTranslation() function. This 
returns three floating point numbers as a parenthesized group (called a tuple): 

print sph.getTranslation() 

This will print the tuple (0.0, 0.0, 0.0) to the Terminal window. You can also set the translation 
and query the new value using the following: 

sph.setTranslation(0.0, -1000.0, 1.0) 

print sph.getTranslation() 

 

Here is the complete python code for this example to enter into the Terminal Window: 

sph = createSphere( 8, 1000, 1.0, 0.5, 0.0) 

sph.setTranslation(0.0, -1000.0, 1.0) 

print sph.getTranslation() 

 

Automation using the VRED API 
For a final example before I start focusing on the UI, I’ll create a python function, then call it to make a 
row of cubes. Python function definitions start with the “def” keyword followed by function name, 
argument list and a colon. Our cube create function takes as input the (x, y, z) location to place the cube. 

def makeCube(size, x, y, z): 

    # Create a cube with a random color 

    # and position at (x,y,z) 

    import random 

    r = random.random() 

    g = random.random() 

    b = random.random() 

    box = createBox(size, size, size, 1, 1, 1, r, g, b) 

    box.setTranslation(x, y, z) 

Paste the above code into the Terminal window at the root: text field. 
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Next, I’ll call makeCube()repeatedly to define an entire row of cubes using python’s “for” statement:  

for x in range(-1000,1000,200): 

    makeCube(100.0, x, 0.0, 200.0) 

Here, I used python’s “for” statement to generate numbers from -1000 to +1000 in steps of 200. This 
generates the sequence: 

-1000, -800, -600, -400, -200, 0, 200, 400, 600, 800, 1000 

We assign the value to the variable x then pass that as the second parameter when we call our 
makeCube function. 

 

Figure 11) Random colored cubes created by calling makeCube() from a for loop 

Here is the complete python code for this example to enter into the Terminal Window: 

# Define a function to make a cube at location x,y,z 

def makeCube(size, x, y, z): 

    # Create a cube with a random color 

    # and position at (x,y,z) 

    import random 

    r = random.random() 

    g = random.random() 

    b = random.random() 

    box = createBox(size, size, size, 1, 1, 1, r, g, b) 

    box.setTranslation(x, y, z) 

 

# Loop through the number -1000 to +1000 in steps of 

# 200 and call makeCube each time 

for x in range(-1000,1000,200): 

    makeCube(100.0, x, 0.0, 200.0) 
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How to create custom user interfaces for VRED  
There are several approaches to creating custom user interfaces for VRED. I’ll outline a variety of ways 
you can create your own using VRED’s API. 

Creating a user interface in a viewport 
VRED’s API contains the vrMenu class to define a menu in the 3D view. You add UI constructs to the 
menu created by vrMenu and you can also transform the menu in 3D. 

First, create the new menu object. The first parameters is the scale factor to apply to the menu, the 
second parameter is the number of columns to provide on the menu for positioning buttons, and the 
third parameters direction of the layout (0 for vertical, 1 for horizontal). Check the VRED Python API 
documentation for vrMenu for details. Here, I create a menu with scale of 0.05, 1 row, vertical layout: 

menu1 = vrMenu( 0.05, 1, 1 ) 

The result is an object of type vrMenu. The vrMenu class contains methods for populating and 
interacting with the menu. Some of the functions provided on vrMenu are: 

Function name Purpose Example 

addLabel 
Creates a label and adds it to 
the menu. 

menu1.addLabel(“Menu”) 

 

addCheckBox 
Creates a clickable check box 
and adds it to the menu. 

menu1.addCheckBox(“Show 
scenegraph”,”showScenegraph(item_state)”) 

 

addPushButton 
Creates a clickable puch 
button and adds it to the 
menu. 

Menu1.addPushButton(“Update scene”, 
“updateScene()) 

 

setTransform 

Changes the 3D transform of 
the menu affecting where 
and how it appears in the 
viewport. 

menu1.setTransform(-1.5, 0, -10, 0, 45 , 0) 

Show Show the menu. menu1.show() 

Hide Hide the menu. menu1.hide() 

There are numerous other functions available on the vrMenu class. Check the Python API 
documentation for details. 



VRED Professional: An API overview with focus on creating custom user interfaces 

 
 12 

 

I can use the above functions to add UI elements to our menu. Note is that pushbuttons and checkboxes 
take an “action” as the second argument, a python command called when the element is clicked. 

Here is an example code snippet extracted from the menu.py demo in the VRED installation area: 

menu1.setTransform(-1.5, 0, -10, 0, 45 , 0) 

menu1.addLabel("<font color=red>Menu</font>") 

menu1.addCheckBox("Rotate cube", cubeInt) 

menu1.addCheckBox("Show scenegraph","showScenegraph(item_state)") 

menu1.addPushButton("Update Scene", "updateScene()") 

The example creates a label (“Menu”), a checkbox that causes a cube to move, a checkbox that toggles 
the SceneGraph window, and pushbutton that calls the API’s “updateScene()” function. When 
menu.py from the VRED installation area is pasted into the Terminal window, a custom menu appears: 

 

Figure 12) A custom menu in the 3D viewport created using vrMenu 

 

The complete code for this example is provided on the following page. 
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Here is the complete python code for this example to enter into the Terminal Window: 

# Create a custom UI using vrMenu. 

# This is the vrMenu.py example provided with VRED. 

print "Executing demo script!" 

 

# First,create a new scene and load a test scene. 

newScene() 

loadGeometry("$VRED_ROOT/examples/geo/cup-test.osb") 

updateScene() 

calcVertexNormals() 

cube = findNodePath("dcs/cube"); 

cube.makeTransform() 

axis = findNode("cube_AXIS"); 

 

# Define interpolator that will be activated over 

# a menu entry. 

cubeInt = vrInterpolator() 

cubeSlide = vrRotationAxisSlide(cube, axis, 0, 359, 8.0) 

cubeInt.add(cubeSlide) 

 

# Define the custom menu using vrMenu amd transform it 

# in perspective in the view. 

menu1 = vrMenu(0.05, 1, 1) 

menu1.setTransform(-1.5, 0, -10, 0, 45 , 0) 

 

# Add UI elements to the menu. 

menu1.addLabel("<font color=red>Menu</font>") 

menu1.addCheckBox("Rotate cube", cubeInt) 

menu1.addCheckBox("Show scenegraph", 

"showScenegraph(item_state)") 

menu1.addPushButton("Update Scene", "updateScene()") 

 

# Use a timer to pause the menu display. 

timer = vrTimer(0.2, true) 

timer.setActive(true) 

timer.connect("menu1.show()") 

 

print "Press Shift and click onto each menu entry" 
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Placing a web interface in the viewport 
The vrMenu class has the ability to display a web interface in place of a menu.  

The complete code to place the web browser inside the viewport as shown in Figure 13 is very simple.  
We create a vrMenu  object, position it in the view, and specify the URL using setUrl with the 
location “http://www.autodesk.com/products/vred/overview/”. 

 

menu = vrMenu(1,1,1) 

menu.setPosition2D(10,10) 

menu.setAutoResize(0.0012) 

menu.setUrl("http://www.autodesk.com/products/vred/overview/") 

menu.setAlpha(0.05) 

menu.show() 

Paste the above six lines of python code into the Terminal window to make the web interface appear. 

 

Figure 13) A web interface inside the 3D view using vrMenu 

 

Here is the complete python code for this example to enter into the Terminal Window: 

menu = vrMenu(1,1,1) 

menu.setPosition2D(10,10) 

menu.setAutoResize(0.0012) 

menu.setUrl("http://www.autodesk.com/products/vred/overview/") 

menu.setAlpha(0.05) 

menu.show() 

 



VRED Professional: An API overview with focus on creating custom user interfaces 

 
 15 

 

Creating UI in a separate window using vrWidget 

The vrWidget class allows you to create UI in a separate window as in the following example.  

 

Figure 14) Custom UI (circled in red) in a standalone window created using vrWidget 

Here is a close-up of the UI window I created: 

 

Figure 15) Close up of custom UI window created using vrWidget 

The vrWidget class allows you to define a UI by specifying a the various elements of the interface 
using a “Qt” specification. Qt is a popular user-interface framework, and is in fact the framework used 
internally by VRED. You can learn about Qt from the excellent online documentation. There are several 
interactive tools available, including QtCreator, that you can use to create the Qt specification. 

When you create the vrWidget, you can either pass the name of a file on disk that contains the Qt 
specification: 

widget = vrWidget("gui/test.ui") 

http://doc.qt.io/qt-4.8/
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Or, create a string in your python code that contains the Qt definition and pass that string as the 
argument to vrWidget: 

widget = vrWidget( uiString ) 

What goes in the Qt definition (file, or uiString)? It’s an XML-format string containing the Qt definition of 
the labels, check boxes, push buttons and sliders that you make up your custom UI. I’ve included the 
complete XML definition for generating the above example in the Appendices. 

The main disadvantage of using vrWidget is that your UI is effectively limited to a single window. 

 

Here is the complete python code for this example to enter into the Terminal Window: 

# widget is an example how to define a gui with Qt's designer 

# and integrate it into VRED. This is the widget.py example. 

 

# define some slots (Qt's name for callbacks) in python 

def returnPressed(): 

    print 'Pressed return in linedit!' 

 

def textChanged(text): 

    print 'Changed lineedit test to', text 

 

def toggledCheckBox(s): 

    print 'Toggled checkbox to', s 

 

def clickedButton(): 

    print 'Clicked button1!' 

 

def valueChanged1(v): 

    print 'Changed spinbox value to', v 

 

def valueChanged2(v): 

    print 'Changed slider value to', v 

 

# create gui from a xml string 

xml = """<?xml version="1.0" encoding="UTF-8"?> 

<ui version="4.0"> 

 <class>Dial</class> 

 <widget class="QWidget" name="Dial"> 

  <property name="geometry"> 

   <rect> 

    <x>0</x> 

    <y>0</y> 

    <width>320</width> 

    <height>275</height> 

   </rect> 

  </property> 

  <property name="windowTitle"> 

   <string>Form</string> 

  </property> 

  <layout class="QHBoxLayout" name="horizontalLayout"> 

continued . . . 
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   <item> 

    <widget class="QDial" name="dial"/> 

   </item> 

  </layout> 

 </widget> 

 <resources/> 

 <connections/> 

</ui> 

""" 

 

dial = vrWidget(xml) 

dial.setToolWindow(true) 

 

# load gui and connect some Qt signals to python slots. The 

Documentation which signals exist 

# can be found on http://doc.trolltech.com/3.3/classes.html 

widget = vrWidget("gui/test.ui") 

widget.setToolWindow(true) 

widget.connect("_lineedit", "returnPressed()", returnPressed) 

widget.connect("_lineedit", "textChanged(const QString &)", 

textChanged) 

 

# connect more than one slot to a single signal 

widget.connect("_button", "clicked()", clickedButton) 

widget.connect("_button", "clicked()", "print 'Clicked button2!'") 

 

widget.connect("_spinbox", "valueChanged(int)", valueChanged1) 

widget.connect("_slider", "valueChanged(int)", valueChanged2) 

 

# creates a new widget2 instance from checkbox, just a test ... 

checkbox = findQObject(widget.getQObject(), "_checkbox") 

widget2 = vrWidget(checkbox) 

widget2.connect("_checkbox", "toggled(bool)", toggledCheckBox) 

 

# find objects within the ui-files created by designer 

# and set their values via a metainterface 

lineedit = findQObject(widget.getQObject(), "_lineedit") 

lineedit.setProperty("text", "Hallo") 

print "lineedit enabled = ", lineedit.getProperty("enabled") 

print "lineedit text = ", lineedit.getProperty("text") 

 

# create a Qt QTextEdit widget via metainterface 

# and set some properties 

text = vrWidget("QTextEdit", vrQObject(), "text edit") 

text.setToolWindow(true) 

text.getQObject().setProperty("caption", "TextEditor Test") 

text.getQObject().setProperty("text", "Hi!") 
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Creating UI in a standalone application 
The UI can exist in a standalone application. Here are some examples: 

 Create a UI that runs in a web browser, written using a language such as HTML, JavaScript etc. 

 Build a standalone application with a language such as C#, C++, java etc. 

 Interface an existing application to VRED . 

The key ingredient is VRED’s “WebInterface”, a port that can be enabled to accept messages from 
external applications. The idea is to enable the WebInterface, have your standalone application connect 
to the port, then have the application draw a UI and send python commands to VRED through the port. 

To enable the WebInterface: 

1)   Go to Edit>Preferences>WebInterface 
2)  Toggle “Enable Web Server” to “on” 
3)  You can change the port number, the default is “8888”. 

You can test the WebInterface from a web browser. On the same machine as VRED is running on, 
type the following string into the web browser’s URL text field: 

http://localhost:8888/  

If VRED’s WebInterface has been correctly enabled, you should see your web browser display the 
following page: 

 

Figure 16) A web browser provides a UI to VRED, sending commands through the WebInterface 

The above illustration shows the default web page sent by VRED when a connection is made. Next, I’ll 
show how to create your own web page to serve as a VRED custom interface. 
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To create a custom UI in a web browser, create a web page and load it into your browser. There are 
example HTML files provided with VRED that provide examples. Try loading one of the HTML files from 
the following folder into your web browser after enabling VRED’s WebInterface: 

C:\Program Files\VREDPro-8.0.3\examples\html 

For example, try loading demo.html. You will get the following displayed in your browser: 

 

Figure 17) A custom UI for VRED running in a web browser 

The above UI allows you to change the port (I case you changed it when you set up the WebInterface in 
VRED), toggle various display settings, and manipulate the loaded scene in VRED. There is a fair amount 
of code involved here, and instead of copying all of it into this document I’ll just mention the key points: 

In demo.html, the first action is to source the JavaScript file utils.js. This file contains utilities for 
issuing commands to VRED. 

The individual UI elements declared in demo.py reference the JavaScript functions to invoke specific 
actions in VRED. 

Here is how to get the custom example UI running in your web browser: 

 Start a web browser 

 Start VRED and it’s WebInterface 

 In your browser, open the file 
c:\Program Files\Autodesk\VREDPro-8.03\examples\html\demo.py 

  



VRED Professional: An API overview with focus on creating custom user interfaces 

 
 20 

 

As noted earlier in this section, standalone custom UIs are not just limited to web browser, you can also 
build a custom UI application in C++ or C#, or can extend an existing application such as Maya to talk to 
VRED through a Maya plug-in that you define. The important thing to note for all standalone 
applications is that they need to communicate with VRED through its WebInterface. Some companies 
may not want to enable the WebIntreface due to security concerns, in which case one of the other 
approaches in this class could be used. 

Using VRED API’s interface to Qt to create a custom UI 
With VRED 2016, you can now access Qt directly from python. This is a tremendous step forward: you 
can now design complex UI panels which are running under VRED. As of VRED 2016 SR1, the “pythonQt”  
interface is available from python (Windows version only: not Macintosh).. 

To build a UI with pythonQt, first declare the modules you require: 

from PythonQt import QtCore, QtGui 

 

Next, create a window and define a layout to add UI elements to. Attach the layout to the window. 

win = QtGui.QWidget() 

layout = QtGui.QVBoxLayout() 

win.setLayout(layout) 

Now declare some UI elements and add each to the layout. 

label = QtGui.QLabel("This is a label") 

layout.addWidget(label) 

button = QtGui.QPushButton("Push me") 

layout.addWidget(button) 

Define a python function that gets called when the button is clicked and connect it to the button. 

def buttonCallback(): 

    print "Button was pushed" 

button.clicked.connect(buttonCallback) 

And finally, we can make the window visible. 

win.show() 

After entering the above instructions into VRED’s Terminal window, the following new window will 
appear on your screen. Try pushing the button and see what happens.  

 

Figure 18) A custom window created with VRED’s interface to pythonQt. 
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If you push the “Push me” button, you will see the print statement “Button was pushed” 
appearing in the Terminal Window. As you can see by examining the code, when the button is pushed, it 
causes the buttonCallback function we connected to the button to be called. 

Compared with the vrWidget interface to Qt, using the pythonQt interface provides more flexibility 
to connect actions to UI buttons and generally create more sophisticated user interfaces. 

Here is the complete python code for this example to enter into the Terminal Window: 

# Import pythonQT modules 

from PythonQt import QtCore, QtGui 

 

# Callback that gets called when our button is clicked 

def buttonCallback(): 

    print "Button was pushed" 

# Create the window and a layout to organize elements we add 

win = QtGui.QWidget() 

layout = QtGui.QVBoxLayout() 

win.setLayout(layout) 

# Create a label and add to the window 

label = QtGui.QLabel("This is a label") 

layout.addWidget(label) 

 

# Create a button, add to the window, and connect to the callback 

button = QtGui.QPushButton("Push me") 

layout.addWidget(button) 

button.clicked.connect(buttonCallback) 

# Make the window visible 

win.show() 

 

 

Notes: 

 There is currently no Macintosh support for pythonQt. Also, in earlier versions of 2016 the 
PySide toolkit was used (very similar to PyQt). 

 It is possible to use a tool such as QtCreator to define your UI then reference the definition 
when you define your UI. However, if your UI is dynamic (e.g. the content changes dynamically) 
it may be better to build the UI programmatically as I have done above. 

 If you need to access the VRED main window, there is a special VRED API function called 

getMainWindow. See the VRED Python Documentation for further details. 
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Summary 
Now that I’ve presented several methods to create user interfaces with VRED, it’s time to outline which 
ones work best in which situations. The following table will summarise to options. 

Approach Technology Pros Cons 

User interface in a viewport vrMenu Only way to get buttons in 
viewport 

Not in separate window 
Limited set of UI functions 

Web interface in viewport vrMenu Create UI using HTML Not in separate window 
Need to use WebInterface 

UI in a separate window 
using QT in XML description 

vrWidget Use QtCreator for layout 
Runs in separate window 

UI is “baked” into XML string, hard 
to hook actions into 
Limited set of UI functions 

External application Standalone 
application 

Can code UI in C#, VB, etc 
Runs in separate window 
Full set of UI functionality 

Need to use WebInterface 
 

UI in separate window using 
QT calls 

PythonQT UI runs within VRED so no 
WebInterface 
Runs in separate window 
Programmed, unlike vrWidget 
which uses “baked” UI 
Full set of UI functionality 

More programming than other 
approaches, though provides 
ultimate flexibility 

 

If you want a custom UI in the viewport, either the first or second approach as appropriate. If you want a 
standalone UI with maximum flexibility and extensibility, use the PythonQt approach because your UI 
will be fully programmable and doesn’t need to use the WebInterface. 
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Appendices  

An introduction to python programming 
There is lots of great documentation online, including a 
tutorial: https://docs.python.org/2/tutorial/index.html. 
It’s important to note that VRED 2016 is using python 
version 2.7.8. You can access VRED’s python interpreter 
by opening the Terminal window in the View menu. Just 
type python commands into the text-field. You can also 
install python on your computer and run it locally You 
can download and install python from www.python.org. 
Types: 
Python variables can be float, int, string or an instance 
of a class (see “Classes” a bit later on). You can also 
have lists e.g. [1, 10, -5] which is a list of integers, akin 
to a “set”. There are also tuples which are enclosed in 
round parentheses, e.g. (10, 5). 
Variables: 
You can assign the result of an operation to a variable. 
Instead of declaring the type of a variable, python 
assigns the type based on the result of the operation. 
Consider dividing 355 by 113.  

almost_pi = 355 / 113.0 

The operation computes as float because 113.0 is float, 
otherwise the equation would compute as int. The 
resulting float value (3.1415929) is assigned to the 
variable “almost_pi” which takes the type float. You can 
print the type of a variable using the “type” operator: 

print type(almost_pi) 

Modules: 
The main power of python is the rich set of libraries 
available. We call these “modules”. For example to 
work with time we could use the time module. Here we 
assign the current date to the variable “today”: 

from time import * 

today = time.strftime("%Y/%m/%d") 

You can query the contents of a module via “dir” 
print dir(time) 

Calling functions: 
The call to “time,strftime” in the previous example is 
calling the “strftime” function that we imported from 
the “time” module. Calling a function simply requires 
specifying the function name followed by the list of 
arguments within parentheses. You can assign the 
result of a function call to a variable, or ignore the 
result if you wish. 
Creation your own function: 
The “def” statement defines a new function. It is 
followed by the name of the function, plus any 
arguments with parentheses, followed by a colon, e.g. 

The next line must be indented by tabs or spaces. It is 
important to use the exact same indent on every line of 
the function. The lines of your function define the 
operations you wish to perform. If you wish your 
function to return a result, use the “return” statement. 

def my_function(redius): 

        r2 = radius * radius 
        c = r2 * math,pi 
        return( c ) 

Call the above function by passing in the radius of a 
circle to get an approximation of the area. 

area = my_function( 10 ) 

Control statements: 
The “if”, ”else” and “elif” statements are some of the 
many control statements available. Use expressions to 
control the logic. Each statement terminates with a 
colon and the “body” of the statement is indented, e.g. 

If area < 100.0: 

  print “too small!” 

elif area > 1000: 

    print “too big” 

else: 

    print “just right” 

Classes: 
A class is a way to define an object containing variables 
and functions that you can create multiple times. For 
example to create a class representing a video in your 
collection you might define one member variable for 
the title, then some functions: 

class myVideo: 

    mTitle = None  # Video name 

    # Constructor 

    def __init__(self, title): 

        self.mTitle = title 

    def title(self): 

        return(self.mTitle) 

To create a video, we simply type the name of the class, 
followed by arguments, and assign to a variable: Let’s 
use a python list: we create a video, then add to list: 

videos = [] 

v = myVideo(“Top Hat”) 

videos.append(v) 

The self parameter provides access to the current 
myVideo object. The __init__ function is the constructor 
and gets called when you create a new myVideo.  
 
Hope this is enough to get you started with python! 

https://docs.python.org/2/tutorial/index.html
http://www.python.org/
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An introduction to PythonQt 

As of VRED 2016 SR1, the PythonQt module is included to 
provide access to the Qt framework. Qt is the same 
framework VRED uses internally for its user interface.  
VRED also supports. In order to access PythonQt you need 
to import the module: 

from PythonQt import QtCore, QtGui 

Creating a window: 
You create a window using the QtWidget() constructor. 

win = QtGui.QWidget() 

To show and hide the window… 
win.show() 

win.hide() 

Layouts: 
Within the window, create “layouts” which are organize 
the contents in a logical way. Here are some layouts: 

 QtGui.QVBoxLayout Arrange content vertically 

 QtGui.QHBoxLayout Arrange content horizontally 

 QtGui.QGridLayout Layout as a row/column grid 
You can place layouts within other layouts, for example, a 
QVGridLayout to organize a window, then a QHGridLayout 
for the individual entries. 
Labels: 
A label is a text or image element. Use labels to denote 
titles that the user cannot change directly. 

u = QtGui.QLabel(“label”) 

You can add the label (also works for buttons etc.) to any of 
the layout types: 

layout = QtGui.QVBoxLayout() 

layout.addWidget(u) 

Buttons: 
A button displays a label or icon the user can click. A 
python function  can be associated with the button that 
gets called when the button is clicked. 

def buttonCallback(self): 

    print “I got pushed” 

button = QtGui.QPushButton("Push me") 

layout.addWidget(button) 

button.clicked.connect(buttonCallback) 

Text fields: 
A text field displays a string and also allows the user to 
change or replace the contents through typing. There can 
be filters placed on the type of input, perhaps only allow 
digits. A python function can be associated with the text 
field that is called when input is entered. 

def editCB(self): 

    print “editing finished” 

edit = QLineEdit('') 

edit.setText(str(355)) 

edit.editingFinished.connect(editCB) 

 

Toggle buttons: 
Toggle buttons contain a toggle box and a label. To 
create, use the QToggle class, 
QtGui.QCheckBox('Show title', self) 

 

 


